Airspace Visualization Display (AViD)
Operation and Maintenance Manual
(AViD-OMM-005)

March 25, 2015
Volume 1: Operation and Maintenance Manual AViD Version 3.5.5
Revision 5


JVN Communications Inc.
3120 Fire Road
Egg Harbor Township, NJ 0823
609-569-1477
www.jvncommunications.com
### Contents

1. AViD Overview ......................................................................................................................... 3
2. Getting Started ........................................................................................................................ 4
3. Applications ............................................................................................................................. 7
   3.1. Surveillance Viewer .............................................................................................................. 8
   3.2. Message Summary ............................................................................................................. 10
   3.3. Dissector ............................................................................................................................ 12
   3.4. Interfacility Monitor .......................................................................................................... 14
   3.5. Surveillance Monitor .......................................................................................................... 16
4. Sources Information Display .................................................................................................. 19
5. Filters ..................................................................................................................................... 21
6. Recording ............................................................................................................................... 22
   Appendix A. Environment Variables ............................................................................................. 23
   Appendix B. Sources File Format .................................................................................................. 24
   Appendix C. Sample Sources File .................................................................................................. 25
   Appendix D. Display File Format ................................................................................................... 26
   Appendix E. Sample Display File ................................................................................................... 27
   Appendix F. Revision History ........................................................................................................ 28
1. **AViD Overview**

The Airspace Visualization Display (AViD) is a tool for viewing and analyzing surveillance data and also displays various types of adaptation such as Host, ERAM, Common Arts and STARS. AViD contains applications that can view, plot, and dissect multiple formats of surveillance data including ADS-B, CD2, MLAT, DASR and networked surveillance data using ECGP. AViD also has the ability to display various map formats and satellite images.
2. Getting Started

Your new AViD tool is configured to boot up to a log in wizard which has all the users listed on the left side of the window. Simply select a user by left clicking on it and type in the password. Then click the log in button at the bottom or just hit enter on the keyboard. After a short loading period the KDE desktop will appear.

![Typical KDE Desktop](image-url)
Once logged in, AViD can be started either by left click on the AViD icon on the lower right side of the display (see illustration below) or by typing `avid` at the command line from a terminal window.

Once AViD is launched the Surveillance Config selection window appears. It lists the available surveillance config files located in the directory specified by the environment variable `SDRR_CFG_FILE`. Select a file to open.
After the surveillance source file has been opened the AViD application main window will appear. If the source file did not contain any user specified applications then the main window will be empty.
3. Applications

AViD applications are launched from the main window menu bar. Left click “Applications” and then select the application to run from the drop down menu. A user can have multiple applications running simultaneously in the AViD main window. Once the desired applications have been loaded the application settings can be saved to a sources file by selecting “File → Save Config”.
3.1. Surveillance Viewer

The Surveillance Viewer application in AViD supports plotting multiple formats of surveillance data. The viewer also displays PDF files and images.

Once the Surveillance Viewer has been selected from the applications menu the user will be prompted for input options. The “Display File” is used to specify the images, adaptation, and maps. The display is optional.

After the input options have been specified and the user selects the 'Ok' button the Surveillance Viewer application will start.
The user selects surveillance sources, images, maps, and adaptation values to be displayed from the View menu. A left mouse click on the target will display a data block of information associated with the target. Right click on the target to display a detailed information window.

The view can be zoomed in or out by using the zoom wheel located on the top right of the main window.

To search for a specific target by BCN or ICAO address select the Find menu and when prompted enter the 3 letter radar name followed by the BCN or ICAO address. To find BCN 3443 in JFK then from the prompt enter JFK3443. If the BCN exists in JFK the target will be highlighted.
3.2. Message Summary

The Message Summary application in AViD displays surveillance messages in a readable format.

Once the Message Summary has been selected from the applications menu the user will be prompted to select the surveillance sources to summarize. To select multiple sources press and hold the CTRL key while selecting. To select a range of sources press and hold the SHIFT key.

![Select Sources](image)

After the input options have been specified and the user selects the 'Ok' button the Message Summary application will start.
The Message Summary application displays messages from all selected surveillance sources by the color specified in the sources xml file. By default the summary is sorted by time. When the “Online” option is checked the application is processing incoming messages and cannot process any user input. If the “Online” option is unchecked the user can sort the summary by selecting a column header. Sorting toggles between ascending and descending when selecting the same column. The application also provides the ability to export the messages to a comma separated value file from the “File” menu option.
3.3. Dissector

The Dissector application in AViD gives a detailed display of surveillance data in asterix format.

Once the Dissector option has been selected from the applications menu the user will be prompted to select the surveillance source to dissect.

After the input options have been specified and the user selects the 'Ok' button the Message Summary application will start.
The Dissector application displays an asterix formatted message in 3 separate panes. The top pane displays the time the message was received and general information such as the type, category, and length. The middle pane displays the selected message details. The details of the message are displayed for each FRN value. The selected FRN’s hex value will be highlighted in the bottom window pane. To stop processing messages deselect the “Online” check box.
3.4. **Interfacility Monitor**

The Interfacility Monitor application in AViD displays the message communication between two specified facilities.

Once the Interfacility Monitor option has been selected from the applications menu the user will be prompted to input optional and required values.

After the input options have been completed the application will start. The facility name and device inputs are required. The Log File input is optional.
The Interfacility Monitor application displays the interfacility messages between 2 specified facilities. Facility one's messages are displayed in blue and facility two's in yellow. The title bar above the messages pane displays the facility names and the devices they are configured to use. The tab displays the name of the monitor specified in the configuration file.
3.5. Surveillance Monitor

AVID can be used as an active monitor for Radar and ADSB, triggering a colored Red/Green/Yellow radar icon symbol when defined values are in/out of defined tolerance.

Values for clock/data and static radar messages are defined in your config.xml file and avid checks the inbound feeds against these values. When the values are correct they will turn green, when all values are correct the radar tab name will turn green. Red indicates a low level issue exists, typically clock or data, while Yellow indicates a less serious value discrepancy. Red can also indicate tolerance issues with test targets, such as BRTQC.
Configuration files can be built automatically using the exportsdrrcfg command with the following options;

```
exportsdrrcfg -a <adaptation> --terminal --staticMsgs="<file>" --avid
```

The –a needs to point to the adaptation location typically containing a site file (.st) to properly parse the sensor data.

Below is an example of an exported (.st) adaptation file that is used by avid to define Radar values.
<radar name="fl3" type="arsr3">
  <static_msg comment="brtqc">
    0x5c2 0x0100 0x820 0x9c0 0xffff 0x0000 0x347
  </static_msg>
  <static_msg comment="srtqc">
    0x922 0x0010 0x020 0x6c0
  </static_msg>
  <static_msg comment="parrot">
    0x6c2 0x1c2 0xc72 0x802 0xb2d 0x0000 0xff6
  </static_msg>
  <static_msg comment="parrot">
    0x6c2 0x320 0xf77 0x902 0xb2b 0x0000 0xff6
  </static_msg>
  <static_msg comment="status">
    0x0c2 0xc20 0x0000 0x807
  </static_msg>
  <static_msg comment="rdvm">
    0x18e 0xf26 0x318 0x9ff
  </static_msg>
  <static_msg comment="rdvm">
    0x18e 0xf46 0x318 0x9ff
  </static_msg>
</radar>

<radar name="mcc" type="asr0-modes" SSRRangeUnits="64.00" genSectorMark="1" PSRrangeUnits="64.00">
  <static_msg comment="brtqc">
    0x4e8 0x0000 0x200 0x1f7 0x0f0 0x0000 0xff6
  </static_msg>
  <static_msg comment="srtqc">
    0x520 0xc0c 0xedc
  </static_msg>
  <static_msg comment="srtqc (correlated)">
    0x920 0x00c 0xedc
  </static_msg>
  <static_msg comment="parrot">
    0x6c0 0xc46 0x9ad 0x802 0x2b9 0x0000 0xff6
  </static_msg>
  <static_msg comment="parrot">
    0x6c0 0xaad 0x9ad 0x802 0x2ba 0x0000 0xff6
  </static_msg>
  <static_msg comment="permanentEcho">
    0x1b0 0x04d 0x9ad 0xedc
  </static_msg>
  <static_msg comment="permanentEcho (uncorrelated)">
    0x1b0 0x04d 0x9ad 0xedc
  </static_msg>
  <static_msg comment="status">
    0x0c0 0x842 0xf93 0x900
  </static_msg>
</radar>

<radar name="mcc" type="asr11" SSRRangeUnits="64.00" genSectorMark="1" PSRrangeUnits="64.00">
  <static_msg comment="brtqc">
  </static_msg>
</radar>
4. **Sources Information Display**

The Sources Information Display can be toggled from the “Sources” menu bar option. This display shows information about the available surveillance sources in AViD. Some of the options are configurable by double clicking on it. These options are black in text and allow for selection. For example, changing the \( \text{wx} \) 0 to 1 will turn on visible weather. Other fields such as color, bcn and src are also changeable. The options seen under the Sources menu are populated directly from the config.xml file, often this is the record.xml. For example of syntax, see Appendix B.
After changing the selected value hit the enter key to apply the change. Changing the color will allow a color pallet selection GUI.
5. Filters

Filters can be added to “filter” the data that is being displayed. To apply a filter click “Filters” from the menu bar. Once clicked a Filter window is displayed from here you can right click and add filters. The available filters are beacon code, altitude, ACID, time and ICAO address. Below is the format for each filter.

- **Bcn**: 4 digit beacon code per line (ex: 4733) will only display beacon code 4733.

- **Altitude**: Altitude stratum per line (ex: 240,300) will only display targets with that altitude.

- **Acid**: Valid Aircraft ID per line (ex: US287) will only display target with that ACID.

- **Time**: Time interval per line (ex: 0/10:00:00.00,0/11:00:00.00) will only display target between 10:00 and 11:00

- **ICAO Address**: 6 hex values per line (ex: ABC123) will only display targets with an ICAO of ABC123
6. Recording

Recording is not dependent on having the AViD application running. Recording is done using the recordcontroller which is located at the bottom right in your task bar. There is a circle that is either red (not recording) or green (is recording).

Right clicking on the button will bring up the control menu (see below).

From there you can start, stop, restart or find the status of recording. While recording, the button will turn green. If you would like to display the AViD application to see IF Monitor or the Counter window double click on the button to launch AViD. The button must be green to launch AViD. If you close AViD it will not stop the recording, that must be done by right clicking on the icon and clicking stop.

The default configuration file is located at /usr/local/cfg/record.xml. The default configuration can be changed by right clicking and selecting change configuration. This will pop up a window that allows you to select a new configuration file.
Appendix A. Environment Variables

AViD uses a number of environment variables to specify various input and output locations. They are listed below with typical values shown in parenthesis.

**AVID**: Location of AViD build (/usr/local/avid.3.2.4)
**ADAPTATION_PATH**: Location of adaptation (/opt/adaptation)
**RECORD_PATH**: Location of recordings (/usr/local/recordings)
Appendix B. Sources File Format

General

The sources file is an xml file which defines the surveillance sources. The following xml attributes are common to all types: (radar, mlat, svol)

- **name**: Used as the title of the display window for this facility, and is matched with the “src” field in the scenario file format for messages (see Scenario File Format)
- **device**: Device or file name.
- **color**: Color of the surveillance source in all applications
- **pos**: position of the radar in latitude / longitude

Radar

Defines a radar sensor.

Optional Parameters:

- **type**: radar type (defaults to LRR)
- **chans**: number of channels (default is 0, which means auto-determine based on type)
- **scantime**: scan time of the radar
- **elevation**: elevation of the radar
- **format**: used to specify the input stream format. (default is CD2)
- **wx**: enables/disables weather to be displayed in AVID
- **bcn**: enable/disable beacon code to be displayed in AVID
- **src**: enable/disable search * to be displayed in AVID

Multi-Lateration

Defines a mlat device.

Optional Parameters:

- **ttl**: time to live
Appendix C. Sample Sources File

Sources example:

```xml
<sources>
  <radar name="qwo" device="/dev/lrr0" type="arsr3" scantime="10.10" elev="1085.00" pos="+39:50:45.00,-083:28:54.00" color="#058f70"/>
  <radar name="sdf" device="/dev/srr1" type="asr9-modes" wx="0" magdev="-3.00" scantime="4.75" elev="502.00" pos="+38:11:05.05,-085:43:36.64" color="#acb213"/>
  <mlat device="multi:224.100.250.8/8250" name="mlt" ttl="8" color="#7b2821"/>
  <radar magdev="140.80" scantime="4.80" format="ast" ttl="10" elev="0.00" device="multi:224.100.250.8/8250" type="asr11" name="bdl" pos="+41:56:18.80,-072:40:57.00" color="#3754a1"/>
  <svol name="sv0" color="#364631" pos="+38:15:01.08,-086:03:02.16">
    <stream device="multi:224.1.1.1/59950" name="UAT"/>
    <stream device="multi:224.1.1.1/59951" name="1090"/>
    <stream device="multi:224.1.1.1/59952" name="Equip"/>
    <stream device="multi:224.1.1.1/59953" name="SVol"/>
    <stream device="multi:224.1.1.1/59954" name="SDP"/>
  </svol>
</sources>
```

Optional Applications example:

```xml
<applications>
  <AdsbViewer useOpenGL="1" display="/usr/local/gsgt/bruce/zid_adsb/gsgt.cfg"/>
  <Dissector>
    <src name="sv0"/>
  </Dissector>
  <MsgList>
    <src name="hnb"/>
  </MsgList>
  <IFMonitor name="zfw-dfw" device1="/dev/if0" facility1="dfw" device2="/dev/if1" facility2="zfw" logfile="/log/ifLog.xml"/>
</applications>
```
Appendix D. Display File Format

General

The display file is an xml file which defines the Surveillance Viewer.

Display tag attributes:
- **width**: width of the canvas
- **radius**: conformal radius
- **scale**: zoom factor
- **projection**: type of projection used
- **height**: height of the canvas
- **name**: name of the display
- **tangent**: point of tangency

Map tag attributes:
- **visible**: display at start of application. 0 = false, 1 = true
- **type**: type of map
- **name**: name of map
- **file**: the map file to load
- **color**: display color of map
Appendix E. Sample Display File

<config>
<display width="3000." radius="3438.41" scale="1.00" projection="stereographic" height="3000." name="ZBW"
tangent="+43:48:33.98,-072:26:24.00">
  <map visible="1" type="noaamap" name="US Map" file="maps/us.dat" color="0,0,255"/>
  <map type="vectorMap" name="ARTCC Map" file="maps/ARTCC_Centers.db" color="200,100,0"/>
</display>
</config>
Appendix F. Revision History

August 24, 2010 (Version 1.0.1 Rev. 1)

- Initial Publication

February 15, 2011 (Version 1.0.1 Rev. 2)

- Added Interfacility Monitor application

April 14, 2011 (Version 1.0.9 Rev. 3)

- Added Auto Record setup

May 29, 2013 (Version 3.2.4 Rev 4)

- Removed recording
- Added Filters
- Editorial Changes

March 24, 2015 (Version 3.5.5 Rev 5)

- Added weather syntax
- Added Radar Monitor
- Added exportsdrrcfg utility
- Added additional Source options
- Adjusted page formatting